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1 ABOUT THIS DOCUMENT 

This document explains how to carry out an indentation measurement using the 
Anton Paar Step - UNHT3 instrument. 
 

For further explanations concerning the platform, refer to the Step X00 
Instruction manual and safety information (IMSI); this document is common 

for every Step X00 measuring/imaging head and mentions important information 
(safety, acquisition system configuration, setup, maintenance/warranty…). 
 

For further information concerning the Anton Paar software, refer to the following 
documents: 
 

 Common Scratch & Indentation software reference guide 
 Indentation software reference guide 
 Video software reference guide 

 
For further explanations concerning the available Anton Paar sample holder, refer to 

the Sample holders user manual. The universal sample holder is used as an 
example in this document. 
 

In this document 
 

- The images may differ from the actual product: 
 

◦ Some print screens are coming from a previous software version but they are 

similar/applicable for V9.0.x version. 
 

◦ Some pictures show previous UNHT3 measuring head design but it doesn't 
change the way to use it. 

 

◦ etc. 
 

- Sometimes several ways to access a software window are possible but only the 
main one(s) is used in this document. However they are all described in the 

software reference guides (like keyboard shortcuts…). 
 

- The units can be different from a print screen to another (e.g. µN, mN or N and 

µm or mm), to change the units, refer to Common Scratch & Indentation 
software reference guide in section Customizing options / Preferences 
tab (units). 

 

- There are some references with a letter and a number '(Z.#)' which are 
described in section 3.3 (Indenter and reference details for handling). 

 

- If not specified, 'Step X00', 'Step' or 'platform' means Step 700 and 700 Noise-
Control if not specified. 

 

- If not specified 'head' means measuring head (UNHT3), as it could be video 
microscope (VID) imaging head or other measuring/imaging head(s). 

 

- 'key(s)' means keyboard key(s). 
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Abbreviations & symbols 
 

Physical quantity symbols are according to the ISO 14577 standard. 
 

Abbreviations 

Symbols 
Designations Units 

ADO adjust depth offset  

AFM Atomic Force Microscope (imaging head)  

Ap projected contact area m2 

E* plane strain modulus Pa 

EIT indentation modulus Pa 

F test force N 

h indentation depth under applied test force m 

hc contact depth of the indenter with the sample at Fmax m 

hmax maximum indentation depth m 

hp permanent indentation depth m 

 (Nu) Poisson’s ratio  

sec seconds  

Step 700 

Surface testing platform with up to 3 measuring 

heads: 
- with optical video microscope imaging head 
- with acoustic enclosure 

- with anti-vibration air table 

 

Step 700 

Noise-Control 

Similar as Step 700, exception: With anti-vibration 

(electronic) active table 
 

UNHT3 Ultra Nanoindentation Tester (measuring head)  

VID optical video microscope (imaging head)  
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2 SAFETY INSTRUCTIONS 

Refer to the Step X00 Instruction manual and safety information (IMSI) in 
section Safety instructions. 
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3 INSTRUMENT VIEWS 

3.1 GENERAL 

 
 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 
 

 
1 Refer to the Step X00 Instruction manual and safety instruction in section 

Instrument overview / General views / VID head. 

  

Universal adapter 

UNHT3 head 
(section 3.2) 

VID head1 

Universal 
sample holder 

Motorized 
X table 

Motorized 
Z table 

Motorized 
Y table 
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3.2 HEAD DETAILS 

 
  

Front Rear 

Reference 
Indenter 
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3.3 INDENTER & REFERENCE DETAILS FOR HANDLING 

Observe the UNHT3 head. 

 

 
Fig.1 UNHT3 head (bottom of the upside down head) 

 

 
A.1  Reference bar 
A.2  Reference 

A.3  Reference Dumbbell 
A.4  Reference glass block support 

A.5  Indenter bar 
A.6  Indenter 

A.7  Indenter Dumbbell 
A.8  Indenter glass block support 

A.9  Steel base 

 

 

When dumbbell (A.3 or A.7) is compressed by the special exchange tool 
(B.1), this releases the corresponding reference or indenter spring 

(located inside the corresponding glass block A.4 or A.8) and allows 
inserting or removing the reference (A.2) or the indenter (A.6). 

  

Front 

Rear 

A.9 

A.8 

A.7 

A.6 

A.5 

A.1 

A.2 

A.3 

A.4 
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Carefully observe the tools which should be used. 
 

 

B.1  Special (self-closing) 
indenter/reference exchange 

tool V2 (version 2) 
has a specific design which needs 

to be understood before 
proceeding with an indenter or 
reference change. This tool is not 

symmetrical, it has a locating tab 
on either side: 

 

● 1 large (B.2) which includes 
2 legs (B.3) 

 

AND 
 

● 1 small (B.4) which contains 
a pin of half-moon section 

(B.5) 

 
 

Fig.2 Special exchange tool V2 orientation 

relative to head orientation 

(bottom of the upside down head) 

B.2  Larger locating tab with 
B.3  Legs x2 

 

B.4  Smaller locating tab with 
B.5  Pin of half-moon section 

B.1 

B.2 B.4 

B.5 

B.5 

B.3 

B.3 

Front 

Rear 
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C.1 (standard) self-closing 

tweezers 

  

C.1 
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3.4 INDENTER-REFERENCE SPACING DISTANCE 

The spacing distance between the standard indenter and reference is: 
 

2.7 ±0.1 mm (Fig.3). 
 
The spacing distance between long shaft indenter and reference used with optional 

liquid cell is: 
 

9.3 ±0.1 mm (4). 
 

 However, the longest spacing distance: 9.3 ±0.1 mm (Fig.4) could have been 

ordered with standard (short shafts) indenter and reference. 
 

  
 

Fig.3 Standard indenter/ 

reference distance 

Fig.4 Long shaft indenter/ 

reference distance 
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4 PATENT 

The Anton Paar Ultra Nanoindenation Tester (UNHT3) design includes active top 
referencing and 3 sensors and is patented under the following number: 
 

US Patent 7,685,868 B2: Measuring head for nanoindentation instruments and 

measuring method 
  



 

G70IB003EN-A 16 

5 INSTRUMENT & MEASUREMENT PREPARATION 

5.1 WARNING: REMOVE HEAD BOTTOM PROTECTION COVER 

 
Fig.5 Head bottom with protection 

cover 

Before operating the instrument, remove 

the head bottom protection cover,  

avoid any collision with the indenter/ 
reference: 
 

Holding/retaining the cover, unscrew its 

2 hand screws and then  doing only 

vertical movement, pull down and 
remove the cover. 

 

(to remount the cover, section 9) 
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5.2 UNIVERSAL ADAPTER MOUNTING/DISMOUNTING 

 
 

The universal adapter 2 lateral holes should be 
placed in front or at the rear. 

Mounting 

 
The universal adapter should be 

mounted on the motorized Z 
table with a large hole located at 
the front left side: 
 

Insert into the large left 
front and right rear holes 

and tighten the 2 screws 
with an Allen key (3 mm) to 
lock the adapter on Z table. 

  

Universal adapter 

Front 

Right 

Motorized Z table 

Lateral 
holes 
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5.3 SWITCHING ON THE INSTRUMENT 

Switch on the instrument; refer to the Step X00 Instruction manual and safety 

information in section Operating the instrument / Switching ON/OFF. 

Then start the Anton Paar Indentation Software by double clicking  on the 

acquisition system desktop. 
 

 

If the platform is equipped with 2 indentation 
heads, select 

"Use instrument : > Step - UNHT S/N: #" 
(UNHT3) from drop-down menu. 

 

5.4 POSITION CALIBRATION OF EACH OBJECTIVE 

The position of each available objective1 is calibrated before leaving the factory. 
However, to perform a new calibration, refer to the Common Scratch & 
Indentation software reference guide in section Managing the instrument / 

Hardware configuration / Control unit & modules tab / I/O card. 
 

 

5.5 VIDEO SCALE CALIBRATION OF EACH OBJECTIVE 

The video scale of each available objective1 is calibrated before leaving the factory. 

However to perform a new calibration, refer to the Video software reference 
guide in section Using the Video software / Toolboxes / Objective / Video 

scale calibration. 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
1 Each objective is mounted on the video microscope turret. 
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5.6 INDENTERS/REFERENCES 

If the indenter/reference is not yet mounted or needs to be changed, read the 

following sections. 
 

 Each time the indenter is changed on the head: 
 

- The corresponding indenter in use should be created and/or selected in 
the software (section 5.6.2). 

 

- The calibration of the distance between the indenter and the video 

microscope should be performed (section 5.10). 
 

- An ADO should be successfully ( ) performed (section 5.11). 
 

 Be sure that each indenter in use: 
 

- Is not too worn out or damaged for the application; periodically verify the 

indenter wear by performing a calibration (section 5.13). 
 

- Is not dirty; periodically or if necessary, clean the indenter extremity 
(sections 5.6.1.3 and 0). 

 
 

5.6.1 DISMOUNTING/MOUNTING 

 It is advised to read all following sections in chronological order before 

manipulating the head. 
 

 

5.6.1.1 Removing the head 

 Before unplugging the head connectors, close the Indentation Software, shut 

down the acquisition system by software (Windows®) and then switch off the 
instrument using the main power switch; refer to the Step X00 Instruction 
manual and safety information in section Operating the instrument / 

Switching ON/OFF. 
 

 

First unscrew (with a small flat 
screw driver) the 2 screws of the 
general sensors connector to 

release it. 
 

Then unplug (pull out/up) the 3 
connectors from the head; 

 do not pull on cable, only on 

connector. 

General sensors 

Piezo Reference 

Piezo Indenter 

Screws 
(x2) 
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 Hold the stand (not shown 

on images) until it is screwed 
on the head as follows. 

 

Place the head (red) stand by 
inserting its 2 captive screws into 

the head holes with an Allen key 
long part (3 mm) and tighten 
these 2 screws, in order to lock 

the stand to the head. 

 

 

 Risk of damage 

The head is equipped with 2 rear pins of a few millimeter inserted into the 

measurement assembly frame. Therefore carefully follow the operations below to 
avoid that the head fall down and be damaged during its removal. 
 

 
 

 
 
 

 

 Push on the stand with one 

hand during the following 

operations. 
 

Unscrew the 2 head upper 
captive screws with the Allen key 

long part to release the head - 
the head is still maintained 
(pushed) with its 2 rear pins 

inserted into the frame.
 

  

Stand 
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From pushing the stand, grab it 

and carefully pull out the stand, 

holding it vertically:  end of 

pins, until the head is removed 
from the frame.

 

 

 

 Carefully bring the head 

over a stable table - avoid 
any collision with the bottom 

of the head where the 
indenter and references are 

located - and follow the next 
steps. 

  

Pins (x2) 



 

G70IB003EN-A 22 

 

Return upside down the head by 
its stand and with other hand 
also hold the head by its rear 

side, near the stand (on head 
frame cover). 

 

Keeping the hand holding by the 

rear side, move the other hand 
over the bottom of the head (on 

head frame cover) without 

touching the indenter and 

reference. 
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With the hand holding the head 

bottom (by frame cover),  

carefully place the head upside 

down on its stand and on the 
stable desk. 

 

The head is ready to mount or 

change its indenter/reference. 
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5.6.1.2 Removing the indenter/reference 

 Carefully read section 3.3 (indenter & reference details for handling) before 

manipulating the head assembly. 
 

 

 On a stable desk, with 

the head is placed 

upside down on its 
stand; see the previous 
section 5.6.1.1 

 Perform all the following manipulations extremely carefully, as there is a 

risk of damaging the UNHT3. Avoid shaking, vibrating the head assembly and 
avoid any collision with it. 

 

 Avoid any collision with the indenter/reference and avoid touching the 

indenter/reference extremity during the following operations. 
 

 

Have special exchange tool 
V2 (B.1) and (standard) self-

closing tweezers (C.1) at 
hand. 
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Place your forearms/elbow on 
the desk to provide greater 
stability during delicate 

manipulations. 

 

Lean your fingers lightly on 
the head casing for better 
stability. 

 
Open (press) widely the 

special exchange tool V2. 
 
Carefully approach with the 

special exchange tool V2 
opened and insert its 2 legs 

(B.3) around and along the 
indenter glass block (A.8). 
 

 Be careful not to press 

on the indenter glass 
block support. 

 

First place the larger locating 
tab (B.2) on the steel base 

(A.9) and press lightly on it 
with the thumb (shown by 
larger arrow). Keep holding 

for the following steps. 
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Fig.6 pin of half-moon section insertion zoom 

 Then Carefully insert 

the pin of half-moon 

section (B.5) between 
the indenter glass block 
side and the side of 

indenter bar (A.5) as 
shown on Fig.6, 

 
and place the smaller 
locating tab (B.4) on the 

steel base in front of the 
glass block. Press lightly on 

the smaller locating tab 
(shown by arrow) and keep 

holding for the following 
steps. 
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Slowly release the special 
exchange tool V2. 
 

This releases the spring in 
the glass block and allows 

the extraction/insertion of 
the indenter. 
 

 Do not move the UNHT3 

head with the special 
exchange tool V2 in 
place. 

 
End of special exchange 

tool V2 installation. 

 

Still press lightly on both 
larger and smaller locating 

tabs and keep holding. 
 

With the other hand take the 
(standard) tweezers. 
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Slowly pull the indenter 
vertically up and release it; 

it should smoothly slide out 
from the glass block. 

 

 Being careful to not 

touch any part of the 
indenter and reference 

axes, gently open and 
remove the special 
exchange tool V2. 
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5.6.1.3 Cleaning the indenter with isopropanol 

 It is recommended to clean the indenter when it is not mounted on the head. 

 
Hold the indenter by its shaft using the self-closing tweezers. 

 
 

 
 

 
 

For the cleaning details, refer to the Step X00 Instruction manual and safety 
information in section Upkeep and cleaning / Cleaning the indenters. 

  



 

G70IB003EN-A 30 

5.6.1.4 Installing the indenter/reference 

Choose a suitable and cleaned indenter (section 5.6.1.3) for the indentation 

measurement. 
 

 
Fig.7 Berkovich indenter 

E.g. a Berkovich indenter is 

chosen; the image shows a 
serial number B-L 89 but in 

this manual, the B-Q 03 will 
be used. 

 

 Go to section 5.6.1.2 to carefully read all warnings and instructions until End of 

special exchange tool V2 installation. Then come back here and continue to 
read the following steps. 

 

 

Carefully take the indenter by 
its head (wider part ending 

with the indenter diamond 
extremity) in the (standard) 

self-closing tweezers. 

V-shaped notch 
on shaft 

Serial number 

V-shaped notch
1
 on shaft 
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Still press lightly on both 
larger and smaller locating 

tabs and keep holding. 
 

Make sure that the V-shaped 
notch1 on indenter shaft 
faces the head rear and is 

perpendicular to the glass 
block length. 

 
With the (standard) self-
closing tweezers, insert the 

indenter into the dedicated 
indenter glass block opening; 

it should smoothly slide into. 
 

 Being careful not to 

touch any part of the 

indenter and reference 
axes, gently open and 
remove the special 

exchange tool V2. 
 

The indenter is locked as the 
released spring pushes the 
dumbbell into the V-shaped 

notch (inside the glass 
block). 

 

1  On the other side of the indenter shaft, there is no notch - only a flat (dedicated for 

 another measuring head), do not orient this flat facing the head rear. Otherwise the 

 indenter will not be locked. 
  

Rear 

V-shaped notch
1
 

on shaft 
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5.6.1.5 (Re)installing the head 

 Perform the manipulations described in section 5.6.1.1 (removing the head) in 

the reverse order to (re)mount the head (together with the mounted indenter 
and reference), being careful of the following steps: 

 

- Push on the stand while tightening the 2 head locking screws. 
 

- Hold/retain the stand while unscrewing and removing its 2 locking screws 

to avoid that the stand fall down and damage the head/instrument. 
 

- Only after the reconnection of the connectors, switch on the instrument 
and then restart the software. 

 

 
 

 
5.6.1.6 Cleaning the indenter by indentation 

The indenter cleaning has been previously done before installing the indenter on the 

head (section 5.6.1.3). However, an indentation at 50 mN in copper can be 
performed to remove any remaining dirt. 
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5.6.2 MANAGEMENT 

Create and/or select the indenter which is mounted on the head ("Indenter in 

use" drop-down menu) as follows. 
 
Select "Instrument > Indenters…" from menu bar to open the following Edit 

indenters window (Fig.8). 
 

 
 

 

 
Fig.8 Indenter(s) creation and/or selection 

If the indenter already exists in 
Configured indenters and a new 
calibration is not necessary, 

select the indenter in use, p. 35 
and later skip section 5.13 

(calibration). 
 

OR 
 

If the indenter already exists in 

Configured indenters and a new 
calibration is necessary, it is 

advised to create a new indenter 
below. 

 

OR 
 

If the indenter does not exist in 
Configured indenters, 

 

create a new indenter 

by clicking <Add> button. 

 
Fig.9 Berkovich type is selected 

This Define a new indenter window 

appears. 
 

Double click on the new indenter 
type. 
 

The following Indenter properties 
window appears (Fig.10). 

Does the indenter 
already exist in 

Configured indenters? 
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Fig.10 Define at least new indenter serial number 

 

Refer to the new indenter certificate to type its Serial number 1 in the corresponding 
filed name (e.g. B-Q 03). 

 

 If necessary: 
 

- Choose another material than diamond; type/edit or select it from 
"Material" combo-box. 
 

 
 

- Theoretical Poisson's ratio and Young's modulus field values can be 

changed. 
 

- Beta field coefficient value can be changed. 
 

Click <OK> button (validation and creation). 
 

 
 

 
 
 

 
 
1 See section 0 to localize the serial number directly on the indenter. 
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Fig.11 New indenter is selected 

 
 

If <OK> button is directly clicked, 
the new indenter creation (in 
Configured indenters) is validated 

and saved but not selected; 
therefore, 
 

select the indenter in use 

from "Indenter in use" drop-
down menu 
 

 
 

and then click <OK> button 
(validation and saving). 
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5.7 SAMPLE HOLDER 

If necessary, the height of the beam (where the measuring and imaging heads are 

mounted on) can be adjusted, depending on the height of the sample/sample holder 
in use; refer to the Step X00 Instruction manual and safety information in 

section Operating the instrument / Adjusting beam height. 
 
Reminders: 
 

- See Universal adapter mounting/dismounting (section 5.2). 
 

-  Each time the sample (the same or a different one) is re/installed in the 

 sample holder, an ADO should be successfully ( ) performed

 (section 5.11). 
 

-  Avoid any collision with the heads, indenter/reference and objective(s) 

 when a sample/holder is removed or installed/mounted. 
 

 The universal sample holder is used as an example in this document. 

 

 
Fig.12 Sample solidly mounted in universal 

sample holder 

Mount the universal sample holder 

(2 screws1 under clamp jaws) on 
the universal adapter. 
 

Then install the sample as level as 
possible in the clamp jaws and 

tighten the 2 hand screws G to 
make sure that the sample 
remains solidly clamped. 

 
 

 
 
 

 
 

 
 
 

 
1 Use Allen key 2.5 mm. 

  

G 

G 
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5.8 POSITION CONTROL 

Select "Instrument > Position control…" from menu bar or click Position control  

 icon on toolbar to open the Position control window (Fig.13). 

 

 
 

 

 

After each power on of the 
Step, the software requires a 

reinitialization of the motorized 
tables before moving them. 
 

 Verify the sample height 

to avoid a collision and 
then click <Yes> button. 

 

The motorized X and Y tables 
move to their extremities; 

wait. 

  



 

G70IB003EN-A 38 

 
Fig.13 Position control window 

 

 
 

 
 
 

The Methods to move the motorized tables/sample either under the indenter, the 
video microscope or the optional AFM1 are described on the following page (p. 39). 

 
Read also Motorized video microscope module, p. 40. 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
1 Refer to the Common Scratch & Indentation software reference guide in section 

AFM measurement or refer to the AFM Wide Scan user manual. 

  

 Always avoid any collision with heads/indenter/reference/objective in use 
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Methods to move 

 Some of the following methods are also applicable to other places in the 

software, exceptions: All 'arrow' icons and vector move buttons are only 

available here in the Position control window (Fig.13). 
 

   

To move motorized X, Y tables/sample 
 

One at a time, keep clicked one of 
'directional arrow' icons 

OR 
Keep pressed one of <'directional 

arrow'> keys1 

      Z height 

To move motorized Z table/sample 
 

Keep clicked Up 'arrow' or Down 

'arrow' icon 
OR 

Keep pressed <PgUp> or <PgDn> 

key. 

    

/  

 

To change moving speed 
 

Select one of Speed radio buttons 

OR 
Press <−> or <+> keys. 

 

If <Ctrl> key is keep pressed before 

moving with the above methods, it 
increases the selected speed. 

Vector move buttons 
 

Click <Vector move> button and set values in the window which appears to move 

accordingly motorized X and/or Y tables. Clicking <Move full> button is similar but 

with motorized Z table in addition (the moving speed is automatic)  verify the 

sample height to avoid collision. 
 

Backlash correction 
 

To achieve better final position accuracy, one can click <Backlash> button. 
 

Closing 
 

Click <Close> button to exit Position control window. The Z table is retracted 
(moving down). 

 
 

 
1 Each single hit on one of 'arrow' keys corresponds to a single : 

 Click  to decrease it (min.) or  to increase it (max.). 

  

1 
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Motorized video microscope module 

If the video microscope module is motorized, 
 

 ensure first that there is no 

risk of collision and then click  to lower the video microscope. 

Click  to raise the video microscope. 
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5.9 VIDEO 

To open the following Video window (Fig.14) from Position control window (Fig.13): 
 

- Click to move under the microscope  icon. The sample moves under the 

video microscope (if it is not already there). 
 

OR 
 

- Click <Open video> button. 
 

 
Fig.14 Video window 

 

Click Cursors  icon on toolbar to open the following Cursors toolbox. 

 

 
 

 

Click <Crosshair>  button to display the video 

crosshair on the middle of the screen (Fig.14). 
 

(Click <Scale>  button to display the scale 

information on the screen.) 
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5.9.1 VIDEO MICROSCOPE 

Click Objectives  icon on Video toolbar (Fig.14) to open the following Objective 

toolbox. 
 
 

 
Displayed objective 

When either the Position control window (Fig.13) or 

the Analyze indentation window (Fig.53) is opened, 
the displayed magnification of the objective should 

match the magnification of the hardware objective 
into working position; otherwise see section 5.4. 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

Front view 

 Manipulate only the turret (part with knurling, 

indicated with grey arrows on image) to rotate 

objectives into their working (vertical) position. 

 

5.9.2 LIGHT ADJUSTMENT 

 
Light intensity 

There are 2 ways to adjust the light source of the 
video microscope: 
 

Manual mode, click <Manual light adjustment> 

 button and adjust the intensity in % by 

dragging the cursor. 
 

OR 
 

Automatic mode, click <Automatic light 

adjustment>  button. 

  

Working position 
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5.9.3 FOCUS ADJUSTMENT 

 When raising the motorized Z table under the video microscope for the focus 

adjustment, be constantly vigilant to avoid a collision between the sample 
surface and the objective but also between the sample holder/sample surface 

and the indenter/reference. 
 

Use the Position control window (section 5.8) to lower or raise the motorized Z table 
to adjust the focus on the sample surface using the Video screen (Fig.14). 
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5.10 INDENTER-MICROSCOPE DISTANCE CALIBRATION 

This section explains how to prepare and perform the calibration procedure of the 

distance between the indenter and the video microscope. For more details and 
information about all features or for a microscope-AFM (optional) distance 

calibration, refer to the Common Scratch & Indentation software reference 
guide in section Managing the instrument / Calibration (Common tabs) / 
there are several sub-sections. 
 

 The round copper sample (provided) is usually used for this calibration. 

 

 As an example in this section: 
 

- Another type of measuring head with Vickers indenter is used for the print 
screens, but the following explanations remain the same or are adapted for 

UNHT3 with Berkovich indenter. 
 

- The video microscope is equipped with the standard 5x objective and optional 

20x and 100x objectives. See section 5.9.1 to know how to properly rotate the 
video microscope turret during the following calibration procedure. 

 

 
5.10.1 SAMPLE HOLDER 

 
Fig.15 Copper sample/stud solidly mounted in 

universal sample holder 

 Properly mount the sample; 

read section 5.7 for 

explanations and warnings. 
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5.10.2 START CALIBRATION 

Select "Instrument > Calibration…" from menu bar to open the following 

Step - UNHT - Calibration window. 
 

 

 
 

 
Fig.16 Distance tab 

Select Distance tab. 
 
Then click <Calibrate> 

button to start the 
calibration procedure. 

The following window 
appears. 

 

 
Fig.17 Calibrate Indenter Microscope distance window 

 
See the following procedure explanations. 
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1. Define mark settings 
 

Location 
 

If it has not been done previously, move the sample under the video microscope to 

find a location1 free of previous indents and clean, in order to perform the 
indentation mark(s) for the calibration. 

To do this, click <Position control…> button (see explanations from Fig.13) and also 
use the Video window (section 5.9). 
 

Load 
 

In Mark load field, set a suitable value to generate a visible indent in the sample: 

50 mN (0.05 N) is advised for copper sample and Berkovich indenter  
(Fig.17 shows 0.5 N (500 mN) which is suitable for another measuring head/ 
indenter). 

 

INFORMATION: If the load value is too big, the mark will be too large to fully see 
it on the Video screen for a high magnification objective (e.g. x100). But if the load 
is too low, the mark will be too small to see it on the Video screen for the x5 

magnification objective. 
 

Number of mark(s) 
 

E.g. <single indent> radio button is selected, only one indentation mark will be 
performed (we assume a previous calibration has been done, otherwise the 4 

indents in triangle shape should be used to better localize them on the sample with 
the Video screen). 

 
2. Mark the sample 
 

Click <Mark sample> button to start the automatic indentation process, in order to 
mark the sample. 

 
If the sample is located under the video microscope, a Warning window asks to 

move the sample under the indenter.  Verify the sample height to avoid a 

collision and then to continue, click <Yes> button (sample moves under the 

indenter; wait). 
 
 

 
 

1  The reference should be able to land on the 

 sample as shown here. 

 

 

 

  

Reference 

Indenter 

Sample 

Max. 2.7 mm 
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As soon as the sample is under the indenter, the 
Microscope distance calibration window appears for the 

automatic indentation process. This window is similar to 
the ADO window (see similar explanations from Fig.25) 

but here it is used only to mark the sample (automatic 
parameters). 
 

At the end of the automatic process, another Warning 
window asks to move the sample under the indenter (for 

the calibration).  Verify the sample height to avoid a 

collision and then to continue, click <Yes> button 

(sample moves under the microscope; wait). 

3. Calibrate 

 
Each available objective of the microscope should be calibrated one at a time by 

centering the indentation mark (previously done) on the Video screen. 
It is advised to start with the smallest magnification x5. 
 

Calibration procedure 
 

 
Fig.18 Real pyramid mark 

(e.g. centered with x100 objective) 

INFORMATION: The sample mark under 

the Video screen is identical as this image 
(Fig.18), that is to say a pyramidal mark 
made with Berkovich indenter in copper 

sample. The following images show a 
square mark, made with a different 

measuring head and indenter (Vickers), but 
the explanations remain the same. 

 

Correctly rotate the microscope turret to 

place the objective into working position  
The corresponding Objective X# (e.g X5) 

area fields become active with the current 
X, Y, Z distance values (coming from the 

previous calibration). 
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Fig.19 Mark centered on Video screen 

with x5 objective 

Use Methods to move, p. 39 (exceptions: 
All 'arrow' icons and vector move buttons) 

to precisely center the middle of the 
indentation mark on the Video screen 

crosshair and also correctly adjust the focus 
on the sample surface (if necessary, click 

<Open video> button to reopen the Video 
window). Then click Redefine calibration 
distance indenter microscope from this new 

point  icon in the active Objective X# 

area to valid the current positon/focus  a 
'tick' icon appears. 

 
Fig.20 Mark centered 

with x20 objective 

One at a time, repeat the previous 
calibration procedure for the remaining 

available objective (e.g. x20 and then 
x100). 

 
Fig.21 Mark centered 

with X100 objective 

INFORMATION: In case of<Four indents in triangle 
shape> radio button has been previously selected, 

center the indentation mark located at the middle of 
the triangle shape (for each objective). E.g pyramidal 
marks made with Berkovich indenter. 

 
Fig.22 Middle mark centered 
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When all available 

objective(s) are 
centered and validated, 

click <Save and close> 
button which becomes 
active (validation). 

 
Fig.23 Distance tab with new values 

Only the new 
calibration values of the 

highest magnification 
(e.g. x100) are copied 

in X and Y distance 
fields. 
 

Click <OK> button 
(validation and saving). 
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5.11 ADJUST DEPTH OFFSET (ADO) 

Each time the indenter/reference or the sample is changed, or the topography on 

the sample area varies, an ADO procedure should be started: 
 

- Because of the vertical variation between indenter and reference. 
 

- To optimize duration of measurement(s). 

 
On toolbar, the icon shows the state of the last ADO: 

Successful  ADO  icon with a green tick 

OR 

Not-successful  ADO  icon with an arrow 

 
See the following sections which explain how to perform a successful ADO. For more 

information about the ADO and its detailed features, refer to the Indentation 
software reference guide in section Adjusting depth offset (ADO).  
 

 
5.11.1 FIND ADO LOCATION 

Move the sample under the video microscope to find a location1 free of previous 

indents and clean, in order to perform the ADO indent; use the following tools: 
 

 Position control (section 5.8) 

 Video (section 5.9) 
 
 

5.11.2 STARTING 

Select "Instrument > Adjust depth offset…" from menu bar or click ADO /  

icon on the toolbar to start the ADO procedure. 

 
 

 
 
 

 
 

 
 
 
 

1  The reference should be able to land on the 

 sample as shown here. 

 

 

 

  

Reference 

Indenter 

Sample 

Max. 2.7 mm 
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5.11.3 PROCEDURE 

 

If the sample is located under the 

video microscope, this Warning 
window appears. 
 

 Verify the sample height to 

avoid a collision. 
 
To continue click <Yes> button, 

the sample moves under the 
indenter; wait. 

The following Adjust depth offset parameters window (Fig.24) appears. 
 

 
Fig.24 ADO parameters 

 
Set the ADO parameters according to the sample in use/application. Parameters 

shown on Fig.24 are coming from the "Presets > Default" drop-down menu and 

are generally suitable to perform a successful ADO ( ) with hard samples. 

 
It is advised to never set a value greater than 70 % in Reference area Pre-approach 
field and lower than 5 % in Indenter area Pre-approach field. 

 Where 100 % means lower position of actuators displacement, it is the rest 

position. 
 
Initial positions: 
 

- Motorized Z table is at 0 mm, in lower (retracted) position. 
- Indenter and reference are at 100 %, in lower (rest) position. 

 
Click <OK> button. The following Adjust depth offset in progress window (Fig.25) 

appears and an automatic procedure starts. 
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 This extra UNHT Approach 

Monitor window1 is also 
present during the 

measurement. 

Automatic procedure 

 
Fig.25 Adjust depth offset in progress window 

Wait for the end of the automatic 

procedure sequences (each current 

status is shown in real time). 

Otherwise if necessary, click 
<Cancel> button to stop any 
movements and to cancel the ADO 

but then, another ADO should be 
started again until it is successfully 

( ) performed. 

 
1 Can be deactivated with the .ini file. 
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 At the end of the automatic procedure, the sample position should be shifted1, 

in order to avoid performing the following calibration or measurement indent 
inside the current ADO indent. The following window (Fig.26) appears. 

 

 
Fig.26 Sample distance displacement after ADO window 

 
Set a min. displacement value (depending on current sample material: 
Approx. 20 x hm) in X and/or Y motorized table field(s) and click <OK> button to 

move accordingly; wait. 
 

OR 
 

Click <Cancel> button and use the Position control (section 5.8) to move the 
sample into another suitable area. 

 

Control that the ADO has been successfully performed (  on toolbar). Otherwise 

see section 10.4 about a non-successful ADO (  on toolbar). 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
1 Not too much, otherwise the sample topography may vary. 

 IMPORTANT: Pay attention to the displacement unit (e.g. µm here), which is set in the 

options; refer to the Common Scratch & Indentation software reference guide in 

section Customizing options / Preferences tab (units). 
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5.12 HEAD DYNAMIC CALIBRATION (WITH SINUS MODE) 

The head dynamic calibration, only available with the Sinus mode, should have been 

performed at least once in order to be able to perform any Sinus measurements, 
including indenter Sinus calibration. 

 

First it is recommended that an ADO have been successfully ( ) performed 

(section 5.11). 
 
Select "Instrument > Hardware configuration…" from menu bar to open the 

following Step - UNHT - Hardware configuration window and select Dynamic ranges 
tab. 

 

 
Fig.27 Dynamic ranges tab 

 
Click <Calibrate> button to open the following UNHT Head Dynamic Calibration 
window; if already performed once, this calibration window (Fig.28) contains the 

last validated values - including the 3 values of Fig.27 - and curves of the previous 
calibration. 

  

A. 

B. 

C. 
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Fig.28 UNHT Head Dynamic Calibration window 

 

Click <Start dynamic calibration> button to start the following semi-automatic 

calibration procedure. 
 

If an ADO has not been yet successfully performed ( ) a Warning window appears 

to ask if the dynamic calibration should be started anyway. It is recommended to 

click <No> button and first perform a successful ( ) ADO (section 5.11). 
 

Then the following additional Head position window (Fig.29) appears. 

 

A. 

B. 

C. 

IMPORTANT: <STOP> button if necessary during the procedure 
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Fig.29 Head position window 

 

Reminder: 
 

The spacing distance between the standard 
indenter and reference is: 2.7 ±0.1 mm 

Click <Position control…> 
button (see from Fig.13) and 

position the motorized X and Y 
tables in order the sample 

extremity is located under the 
UNHT3 reference only, not 

under the indenter.  If the 

motorized Z table is manually 

raised (to better targeting), 
never touch the sample 
surface with the reference 

(/indenter). 
 

Before clicking <Ok> button to 
continue, be aware that in 

UNHT Head Dynamic 
Calibration window (Fig.28), 
<STOP> button will be active 

and can be clicked if necessary 
to interrupt any movement. 

Then the motorized Z table automatically approaches (raises) until the sample 
surface contact the reference. 

 
An ADO in progress window appears (it is similar than Fig.25, but here it is used 
only for the following head dynamic calibration; there is no need to set any ADO 

parameters). 
 

In UNHT Head Dynamic Calibration window (Fig.28) 
   

 
 
 

 
 

 

 

1. Positioning the indenter… 
circle status blinks green; 
wait a few sec, the indenter 

is positioned at the 
displayed value. 

 

2. Mass Calibration running… 
circle status blinks green; 

wait a few sec, the mass 
calibration runs (the curves 
in the 2 upper graph areas 

are displayed/updated). 

  



 

G70IB003EN-A 57 

 

 

3. Phase calibration running 
circle status blinks green; 

wait some minutes: 

The phase calibration runs: the frequency value increases (till 100 Hz) and the 
measurement curves are displayed on real time in the Results bottom graph area. 

 

 
 

 

4. When the phase calibration 
measurement is done, the 

indenter and reference are 
retracted: Removing the 

indenter… circle status 
blinks green; wait a few 
sec. 

 

The new calibration values are 

updated on the top right 
corner of the main window and 
all new curves are displayed 

accordingly in all graph areas. 
 

Click <OK> button at the right 
bottom of the window 
(validation). 

  

A. new 

B. new 

C. new 
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... 

 
 
Back in Hardware configuration window, the 3 new Dynamic coefficients field values 

are automatically updated according to this last performed dynamic calibration. 
 
IMPORTANT:  

- Do not forget to click <Validate range values> button (validation of these new 
range (calibration) values) and then click <OK> button (saving). 

- As new range values have been validated, a new and successfully ( ) ADO 

should be performed (section 5.11). 

  

A. new 

B. new 

C. new 
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5.13 CALIBRATION OF INDENTERS (QUASISTATIC OR SINUS) 

The calibration of indenters can be either performed with the standard quasistatic or 

Sinus method;  in case the Sinus calibration is selected, the dynamic calibration 

should have been previously performed (section 5.12). The quasistatic calibration is 
used as an example in this document, but specific explanations for the sinus 
calibration are described in addition. 

 

 It is highly recommended to perform a calibration of the indenter in use if: 
 

- It has never been done. 
 

- It has already been done but some time ago, the indenter might have worn 

out in the meantime. 
 

 If the indenter is not calibrated, its geometry is approximated to a perfect 

shape tip. For Berkovich and Vickers indenters, the theoretical function 

Ap = 24.5 hc
2 is used to approximate the area function. 

 

 The certified reference Fused Silica sample should be used for this calibration. 

 
The indenter calibration procedure is performed in order to define the Ap function of 

the indenter vs. the contact depth; it basically includes in the following order: 
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 Automatic ADO (with automatic move in X direction straight after the ADO) 
 

 calibration measurements: 
 

◦ a matrix of indents for a quasistatic indenter calibration 
 

 40 (5x8), 45 (5x9) or use as an example in this manual, 60 indents (10x6): 
 

 
 

OR 
 

◦ a single row of a chosen number of indents for a Sinus indenter calibration 
(advised number is 5 indents) 

 

 … (spaced by 25 µm) 

 

 contact area determination (verification/redefinition of all contact points of the 
matrix of indents, removal of bad indents and fit method) 

  

Matrix of 
60 indents 

6 rows 

2x [5 indents with same load] 
Load decreases every 5 indent 

−25 µm 

−25 µm 

ADO indent 

25 µm 

25 µm 
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5.13.1 SAMPLE HOLDER 

 
Fig.30 Fused Silica sample/stud solidly mounted 

in universal sample holder 

 Properly mount the sample; 

read section 5.7 for 

explanations and warnings. 

 
5.13.2 FIND ADO & CALIBRATION AREA 

Move the Fused Silica sample under the video microscope to find an area1 free of 
previous indents and clean, in order to perform the ADO indent and then the matrix 

of indents for the calibration; use the following tools: 
 

 Position control (section 5.8) 

 Video (section 5.9) 
 
 

 
 

 
 
 

 
 

 
 

 
 

1  The reference should be able to land on the 

 sample as shown here. 

 

 

 

  

Reference 

Indenter 

Sample 

Max. 2.7 mm 
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5.13.3 STARTING 

Select "Instrument > Indenters…" from menu bar to open the following Edit 

indenters window (Fig.31). 
 

 

 
 

 
Fig.31 Edit indenter for calibration 

The new "Indenter in use" has been 
previously created and selected 
(section 5.6.2), so it is automatically 

selected (highlighted) in Configured 
indenters. 

 
Click <Edit> button. 

 
The following Indenter properties 
window appears (Fig.32). 

 In Configured indenters: If a same indenter with an old calibration date is 

selected and then edited by clicking <Edit> button for a new calibration, the 
previous Ap curve (Fig.42) will be overwritten. Thus, it is advised to create a 
new indenter (section 5.6.2). 

 

 
Fig.32 Perform indenter calibration 
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5.13.4 PROCEDURE 

Click <Calibrate> button in Fig.32 to start the following indenter calibration 

procedure. 
 

 

E.g. <Measuring a new 

matrix of indentation> radio 
button (quasistatic) is 

selected (by default). 
 

OR 
 

Select <Measuring a new 
matrix of sinus indentation> 

radio button (Sinus). 
 

 If necessary, a previous 

saved calibration file .mit 

can be reloaded by 
selecting 

<Loading indentations 

from file> radio button 
(quasistatic) 

 

OR 
 

<Loading sinus 

indentations from file> 
radio button (Sinus) 

 

Then click <Next> button. 
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Choose the indenter calibration parameters. 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 

 

 
 

With certified value - 
ADVISED 

 

Select <E* Method> radio 
button, in its field set the 

Plane strain modulus (E*) 
value stated on the 
delivered certificate of the 

Fused Silica sample and 
press <Enter> key. 

 

OR 
 

With theoretical values 
 

Select <EIT Method> radio 

button, in its corresponding 
fields set the Poisson’s 

ratio and Young modulus 
values corresponding to 
the sample. 

 
Then select the calibration 

mode: 
 

E.g. the quasistatic mode, 
<Intensive> radio button 

(matrix of indents) is 
selected (by default). 

 

OR 
 

If previously the Sinus 

procedure has been chosen, 
the Sinus Mode <Std> radio 
button is selected: 
 

Set the row indents 

number in Measurements 
field; advised value is 5. 
Every indent will be 

performed with Sinus 
Constant Strain Rate 

0.05 1/s, load 40 mN, 
amplitude 1 mN, 

frequency 5 Hz. 
 
And then click <Next> 

button. 
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Click <Next> button. 
 
The following window (Fig.33) 

appears. 

 
Fig.33 Wait time window 

Click <Skip> button to 

directly start the automatic 
calibration measurements 
(matrix of indents). 

 

OR 
 

Delay the measurements, 
e.g. to have the lowest 
noise environment (during 

the night): 
 

Set the time at which 

the measurements will 
start and click <Wait> 
button. 

 

Remaining time before 
starting the 

measurements is 
displayed 

 
(blinks). 

 
5.13.4.1 Measurements 

Then ADO in progress window (Fig.25) appears. (Here, there is no need to set any 

ADO parameters; they are automatic and optimized for this indenter calibration). 
 
And then Indentation running… windows (Fig.52) appears; wait for automatic matrix 

of measurements for the calibration are performed. 
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E.g. quasistatic calibration matrix of indents is performed 
(totally 60 indents) 

 
- Each row includes 2x [5 indents at the same load]. 

 

- The load decreases every 5 indent. 
 

- The weakest load is reached at the 6th row. 

 

 
Fig.34 Matrix with 5x video microscope objective 

 
Once the last measurement has been completed, the following Save a calibration file 

window (Fig.35) appears. 
  

Matrix 

ADO 

1st row 

6th row 
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5.13.4.2 Saving 

 
Fig.35 Save a calibration file window 

Calibration date 

The date which is included in 
the file name (in addition to 

the indenter serial number) 
corresponds to the date when 
the calibration measurements 

started (can be modified). 
 

The date which is included in 
the Indenter properties window 
(Fig.42) and next to the serial 

number of "Indenter in use" 
+ Configured indenter in Edit 

Indenters window (Fig.44) 
corresponds to the date of the 
last matrix indent 

measurement. 

Choose a location to save the file of the indenter calibration measurements on the 
acquisition system and click <Save> button. 
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5.13.5 CONTACT AREA DETERMINATION ADJUSTMENT 

 
Fig.36 Contact area determination window 

 
First all load indent automatic contact points should be verified/refined and then all 
bad indents should be excluded as explained in order in the followings sections. 

 

It starts with the first indents1 (e.g. 5) of the lowest #1 load1 . 

 
Click <Set contact point> button. The following Set the contact point window 

(Fig.37) appears, see the explanations in the following sections. 
 

 
 
 

 
 

 
 
 
1 Not applicable for Sinus measurements (same load for all indents). 
2 With Sinus measurements, it could be less or more than 5 indents. 

  

5 indents
2
 

related to 
the current 

load 

Current 

load
1
 

Total of indentations (5 indents) at 
12 different loads 
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5.13.5.1 Automatic contact points 

Each indent contact point (several with matrix) has been automatically defined by 

the software  in Fig.37: Automatic positions of the red cursors on left graph area 
and Detect contact point  icon is inactive on toolbar. However, it is advised to 
verify and if necessary to refine (more precisely) each contact point for all current 

indents1 (e.g. 5) of all loads2 (e.g. 12) as follows. 
 

 
Fig.37 Set the contact point window 

 
Verify/refine contact point for each current load indent 

 

 
 

 
In the indent selection area, it starts with the first indent #1 (highlighted). 

One at a time, select (highlight) each indent # to verify and if necessary 
refine its contact point as instructed in section 5.13.5.2. 
 

Once the 5 current load indents has been verified/refined, click <OK> 
button (validation and saving of each indent current contact point). 

Then, Select the next load, p. 70. 

 
 
 

 
 

 
1 With Sinus measurements, it could be less or more than 5 indents. 
2 Not applicable for Sinus measurements (same load for all indents). 

  

Indent selection area 
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Select the next load 

In Contact area determination window (Fig.36): 
 

Click <'next'>  button to skip to the next load , then click again 

<Set contact point> button and Verify/refine contact point for each current load 
indent, as explained in p. 69. 

 
 Repeat the previous instructions for all available loads. 

 

 Click <'previous'>  button to skip back previous load (to verify/refine 

again contact points if necessary). 
 

When all indent contact points of all loads have been verified/refined (e.g. 5 x 12 = 
60 indents), remove the bad indents of all loads (those which are shifted and/or 
have a bad shape) as instructed in section 5.13.5.3. 
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5.13.5.2 Verify/refine contact point procedure 

The best contact point is located where the F red curve starts to rise1 and/or h 

green curve starts to peak. If the red cursor are not at this specific location, double 
click to refine the new and more precise contact point  red cursors move 
accordingly (Fig.39). 

 

 
Fig.38 Auto detect contact point 

 
Fig.39 New user refined contact point 

 
End of the verified/refined contact point procedure. 
(Clicking Detect contact point  active icon, recover initial automatic contact point  icon 

 becomes again inactive). 

 
 
1 The higher the load the more difficult it is to see the F red curve rising, so use the h green 

curve instead to determine the best contact point. 

 
 

 

  

h F 

New and more precise 
contact point 
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5.13.5.3 Features and removal of bad indents 

 
Fig.40 Bad indent #3 is removed 

 
Display 

 

 Initially all Indent # boxes are checked in selection area. 

 
By default <Multi> button is selected, otherwise click it to display each 5 indent 

curve2 on the same time on the graph. 
 

To display only 1 indent curve at a time on the graph, click <Single> button and 

place the mouse cursor on a desired Indent #  in selection area, 

 With <Multi> button selected, placing the mouse cursor on a Indent # 

 highlights the corresponding curve on the graph. 

  

Indent selection area 
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Graph area 
 

Different types of curves can be selected to show the 5 indents1 of the current 
load: 

- By default Indentation curve  icon is selected to show F vs. h curves 

(Fig.40). 
or 

- Click Fn  icon to show F vs. time curves. 

or 

- Click Pd  icon to show h vs. time curves. 

OR 
Circles can be selected to show indents (e.g. 5) of all loads (e.g. 12): 

- Click Ap  icon to show Ap vs. hc circles: The indents of the current load 

are represented by colored circles and the remaining indents of all other 
loads are represented by gray circles. 

By default a linear scale is displayed (log  icon unselected) or  

click log  icon (becomes  selected) to display logarithm scales 
 

 
 

Fig.41 Circles are displayed 

 

Click Relevant only  icon to show the relevant curves or circles  the gray curves 

or circles are hidden from the graph (see above for gray circles, and see removal of 

bad indent below for gray curves/circles). Click again the selected icon  to 

display the 5 indent curves or all indent circles. 

 
Removal of bad indents 

E.g. in Fig.40 for the selected load: Indentations # 3/12, the Indent # 3 is totally 
shifted (even with a correct contact point) and has a bad shape; uncheck each bad 

Indent #  box to exclude them   On the graph area it becomes 

gray  not relevant (excluded for the Ap determination). 
 

When all bad indents have been removed, click <Next> button in Fig.40. 
  

Bad shape Indent # 3 
Indentations # 3/12 

is removed 
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step 5 

Ap curve appears. 
 

The Scale Mode: can be 
changed from <Linear> to 
<Log> and vice versa (click 

the desired radio button). 
 

Click <Finish> button. 
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5.13.6 EDIT FIT METHOD 

 
Fig.42 Ap curve appears in indenter properties window 

(linear mode) 

 

The scale mode can be changed from linear Ap  icon to logarithmic Log  icon 

and vice versa (select desired icon). It is also applicable in the following Edit fit 

method window (Fig.43). 
 
Ap curve appears in the graph area of the Indenter properties window and uses by 

default the automatic BSplines Interpolation Fit Method. However it is possible to 
use other methods: Click <Edit fit method> button to open the following Edit fit 

method window. 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
1 See Calibration date, p. 67. 

  

BSplines Interpolation 

1 
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Fig.43 Edit Fit Method window (logarithmic scale) 

 

Several edit fit method can be chosen, click the following desired radio button; for 
further explanations, refer to the Indentation software reference guide in 

section Ap(hc) Fit method of the calibration: 
 

<BSpline interpolation> radio button (standard by default) 
 

OR 
 

<Linear Interpolation> radio button 
 

OR 
 

<Oliver & Pharr> radio button (and set Fractional terms fields) 

 
 

OR 
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<Polynome> radio button (and set Degree fields) 

 
 
Once the desired method has been selected (and set for Oliver & Pharr and 

Polynome), click <OK> button in Fig.43 (validation). 
 
Then click <OK> in Fig.42 (validation and saving). 

 

 
Fig.44 Indenter B-Q 03 25.07.2014 has been 

calibrated and is (still) selected 

And then verify that the 
indenter in use, which has just 

been calibrated, is (still) 
selected. 
 

Otherwise select it and click 
<OK> button (validation and 

saving, section 5.6.2). 
 

 The calibration date1 has 

been automatically added 

next to the indenter serial 
number name. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
1 See Calibration date, p. 67. 

  

1 

1 
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6 INDENTATION MEASUREMENT PROCESS 

This section explains how to prepare and carry out an indentation measurement. 
 

 For the following indentation measurement process example, the Fused Silica 

sample (provided) is in use. 
 

 

6.1 SAMPLE HOLDER 

 The sample should be solidly mounted to prevent movement when under load. 

 

 
Fig.45 Fused Silica sample/stud solidly mounted 

in universal sample holder 

 Properly mount the sample; 

read section 5.7 for 
explanations and warnings. 

 

6.2 OPEN OR CREATE NEW DOCUMENT 

To start a new indentation measurement, a document should be opened or created 
as follows. 

 

Select "File > Open…" from menu bar or click Open  icon on toolbar to open an 

existing measurement document: 
 

'File name'.mit 
 

Select "File > New…" from menu bar or click New document  icon on toolbar to 

create a new document. The following Indentation group information (Fig.46) 
window appears. 
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Fig.46 Indentation group information window 

Fill in the fields and 

especially set the correct 
Poisson’s ratio value, e.g. 

0.160 corresponds to the 
Fused Silica sample in use 
(provided)  Adapt this 

value for each sample in use 
as it will affect the EIT main 

result. 
 
Fused Silica sample has no 

coating. However if another 
sample with coating(s) is 

used, click <Add> button 
(many times if several 

layers) to open the following 
window (Fig.47). 

 
Fig.47 Layer definition window 

Fill in or select the combo-

boxes about the details of 
the layer definition. 

 
Then click <OK> button 

(validation). 

Then click <OK> button in Fig.46 (validation and creation of the new document). 
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6.3 PERFORMING AN INDENTATION MEASUREMENT 

6.3.1 ADO 

If an ADO has already been successfully ( ) performed on the current sample, 

skip this section. Otherwise an ADO should be performed (section 5.11). 
 

 
6.3.2 FIND MEASUREMENT AREA 

Move the sample (e.g. Fused Silica) under the video microscope to find an area1 

free of previous indents and clean, in order to perform the indent (or matrix of 
indents) measurement; use the following tools: 
 

 Position control (section 5.8) 
 Video (section 5.9) 

 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 

1 : 

- Not too far from the current ADO indent (otherwise sample topography may vary). 
 
 

- The reference should be able to land on the 

sample, as shown here. 

 

 

 

  

Reference 

Indenter 

Sample 

Max. 2.7 mm 
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6.3.3 DISTANCE BETWEEN INDENTS 

Indentation marks should be separated by a minimum distance to avoid influence of 

previous indent on the following one. 
 

 

To avoid that elastic field of 

each indent overlaps, the 
minimum recommended 

distance between each indent in 
X and/or in Y directions should 

be: 
 

ΔXY > 30 x hmax 

 
 

 
 

 

6.3.4 DEFINE INDENTATION MEASUREMENT PARAMETERS 

The Standard measurement type is described in this section. However the Sinus 
measurement type is described in addition. 

 
Select "Instrument > Start a new indentation…" from menu bar or click 

Indentation  icon on toolbar to open the following Define a new measurement 

window (Fig.48). 

  

Elastic 
deformation 

ΔXY
 

Minimum 
distance 

F 

h 
hp hmax 
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Fig.48 Measurement type selection 

Double click on a 
measurement type, e.g. 

Standard. 
 

The corresponding 
parameters window appears 

as follows (e.g. Fig.49). 
 

 For a Sinus 

measurement type, the 
dynamic calibration 

should have been 
previously performed 

(section 5.12). Then 
double click Sinus in 

Fig.48. 

 
Fig.49 Standard window with measurement 

parameters 

Click <Change> button to 
open the following 

Step - UNHT - 
Hardware parameters 

window which includes 2 
tabs. 
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Fig.50 Preferences tab parameters 

 

In Preference tab 
 
Settings for the Indenter approach parameters, Reference approach parameters and 

Approach specification areas shown in Fig.50 are examples (suit for the Fuse Silica 
provided sample) and should be set according to the sample in use/ application. 

 
It is advised to set the Indenter and Reference Pre-approach fields with the same 
values as set for the current ADO (Fig.24). 

 
Optical analysis after measurement box is checked in Video area for section 6.3.6. 

 
For more details and information about the remaining features (Reference-indenter 
auto-tuning and Presets areas), refer to the Indentation software reference 

guide in section Taking a new measurement / Setting the measurement type 
parameters / Measurement hardware parameters (head) / UNHT 

Preference tab and Preset of the preference parameters. 
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Select Sensor ranges tab. 
 

 
Fig.51 Sensor ranges tab parameters 

 
Select the Reference load range, Indenter load range and Depth ranges <radio 

buttons> according to the sample in use/application (e.g. all fine ranges are 
selected in Fig.51). 
 

 It is recommended to use the fine Depth range. However if the depth saturates 

during the measurement, then select the large Depth range. 
Depending on the instrument version, it is possible that the large Depth range 

value is different than the one shown above. 
 

Click <OK> button (validation and saving for current parameters of the 2 tabs). 
 
 

SETTING OF THE INDENTATION MEASUREMENT PARAMETERS 
in Fig.49 

 

 Indentation measurement parameters shown in this section are suitable for the 

provided Fused Silica sample. For any other applications, the parameters 

should be set according to the type of the sample in use. 
 
Standard indentation parameters area 

 
Max load field: Set a suitable value, e.g. 10 mN (with Fused Silica 

sample). 

Fine 

Large 
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Load Time: 30 s 
Unload Time: 30 s 

info 

For this kind of measurement, these values are automatic 
(30 sec). To change them, another type of measurement 

should be selected (Fig.48). 

Pause field: E.g. set to 10 sec (0 = no pause). 

Estimated time 
inactive field 

Information for the estimated measurement duration 
(depend on measurement and hardware parameter 

settings). 

Estimated memory 
size inactive field 

Information for the estimated RAM memory size needed to 
perform the measurement (depend on the measurement 
and hardware parameter settings). 

 

For the following Sinus measurement type (some parameters are already explained 
above) 

 
4 parameters are common for the 2 sinus measurements profiles  
(Max. Sinus amplitude and Sinus frequency fields and <Constant depth> or 

<Linear load> radio button). 
 

 

Select Linear loading tab 
 

 
and set all these parameters. 

OR 
 

 

Select Constant strain rate tab 
 

 
and set these parameters. 

Then click <OK> button in Standard window (Fig.49, or other measurement type 
window: Sinus…) to run the indentation measurement (+ validation and saving of 

current parameters). 
 

 For further details about the Indentation measurement types, hardware 

preferences and measurement parameters, refer to the Indentation software 
reference guide in section Taking a new measurement / Selecting the 

measurement (type or protocol) and Setting the measurement type 
parameters. 
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6.3.5 RUN INDENTATION MEASUREMENT 

 

If the sample is located under 
the video microscope, this 

Table displacement Warning 
appears. 
 

 Verify the sample height 

to avoid collision. 
 

To continue click <Yes> 
button, the sample moves 
under the indenter; wait. 

The following Indentation running… window (Fig.52) appear; wait until the following 

automatic indentation measurement ends. 
 
1. The motorized head module approaches (moving down) 

 
Status area (following squares blink) 

 
2. Approaching Table Z…  
 

3. Approaching reference %  
 

4a. Approaching Indenter  
4b. Stabilization [s]  
 

5. Indentation running…  (e.g. Fig.52) 
 

6. Removing the indenter…  
 
7. The motorized Z table retracts (moving down) 

 
8. The motorized head module retracts (moving up) 
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 Graph curves are displayed in real time. 

 

 
Fig.52 Indentation measurement is running 

 

 

When the indentation 
measurement(s) is completed, it is 

possible1 to move the sample 
under the video microscope, in 

order to analyze/visualize each 
indent (several if matrix has been 

performed). 
 

 First verify the sample height 

to avoid collision and then 
click <Yes> button; wait. 

Then the following Analyze indentation window (Fig.53) appears. 
 

 
 
 

 
1 If Optical analysis after measurement box has been checked in Fig.50 (Hardware 

parameters window/Preferences tab). 
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6.3.6 ANALYZE/VISUALIZE EACH SELECTED INDENT 

 
Fig.53 Analyze indentation window 

 

The Video window (Fig.14) is opened, otherwise click Show live image  icon. 

 

If there are several indents (matrix), select in the Indentation definition list each 
indent one by one to take Images, p. 89 (optical, optional AFM if available). 

 
If the indent or one of the indents (matrix) is not exactly centered on the video 
screen crosshair, there is no need to restart a complete Indenter-microscope 

distance calibration (section 5.10), a recalibration can be performed from this 
window: 
 

Retarget1 the indent center on the video crosshair and click Redefine calibration 

distance indenter microscope from this new point  icon: New calibration values 

for X, Y and Z distance are automatically saved in the corresponding field of 
Calibrate Indenter Microscope distance window (Fig.17). 

 
 
 

 
 

 
 
1 On the Video screen adjust the focus and move by using Methods to move, p. 39 

(exceptions: All 'arrow' icons and vector move buttons). If necessary, click Return to 

current indentation  icon to return to the original video position (as it was before 

moving). 
  

Gallery of image thumbnails 

List 
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Images 

Images1 can be taken by clicking <Video image> button (Fig.53), which opens Edit 
an image window (Fig.54). 
 

Multifocus images can be taken by clicking <MultiFocus image> button (Fig.53). 

 For further details about MultiFocus image, refer to the Indentation software 

reference guide in section Taking a new measurement / 
Analyzing/visualizing the indentation(s) / Optical analysis (includes 

setting contact point). 
 

 
Fig.54 Edit an image window 

 
 

 
If an image thumbnail is clicked, the corresponding image is displayed in large 
format. Additional options are available (as image title, comments…). 

 
When <OK> button is clicked, the image thumbnail is created inside the gallery of 

the Analyze indentation window (Fig.53). 
 
 

 
 

 
1 On the Video screen adjust the focus and move by using Methods to move, p. 39 

(exceptions: All 'arrow' icons and vector move buttons). 

  

Measurement indent 

Gallery of image thumbnails 
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In Analyze indentation window (Fig.53), when the optical analysis is completed (for 
each indent if several and if needed), click <Finish analysis> button. 

 

 

This Confirmation window appears. 
 

If <Yes> button is clicked, it will not be 
possible to come back to this Analyze 

indentation window  The motorized Z 
table is retracted (moving down); wait. 

 

6.3.7 SAMPLE DISPLACEMENT AFTER MEASUREMENT(S) 

After the measurement(s) is performed or after visualizing the indentation(s) 
(previously described), the sample position should be shifted1 to avoid performing 

the next indentation measurement inside the current measurement indent. The 
following window appears and is comparable to the one after the ADO automatic 
procedure; refer to the similar explanations from Fig.26. 

 

 
 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
1 IMPORTANT: Pay attention to the displacement unit (e.g. mm here), which is set in the 

options; refer to the Common Scratch & Indentation software reference guide in  

section Customizing options / Preferences tab (units). 
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7 RESULTS ANALYSIS 

Results and graphic curves of the indentation measurement (sheet 1 bottom tab) 
are created in the main Indentation Software window (Fig.55); Show the curve view 

 icon is selected (default) on toolbar. 

 

 
Fig.55 Indentation measurement results for analysis 

 

 
 
  

Measurement sheet 1 bottom tab Gallery of image thumbnails 
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7.1 VIEWING MODES 

The previous graph area (Fig.55) shows the combined curves, force vs. indentation 

depth as Indentation curve  icon is selected. 

 

Other viewing mode(s) is available (Fig.56): 
 

Click Fn icon to show/hide F red curve vs. time. 
 

AND/OR 
 

Click Pd icon to show/hide h green curve vs. time. 

 

 
Fig.56 Both F and h vs. time are displayed 

  

h F 
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7.2 CONTACT POINT(S) 

Each indent contact point1 (several if matrix) has been automatically defined by the 

software. However, it is advised to verify and if necessary to refine (more precisely) 
each contact point as follows. 

 
Select "Edit > Indentations > Set contact point…" from menu bar or click 
Detect contact point  on additional toolbar (Fig.55) and follow the same 

explanations from section 5.13.5.1, exceptions: Here1 there is only one indent 
(one load). 

 

 

Here the results are calculated with the contact 

point automatically defined by the software  
Detect contact point  icon is inactive on Set the 

contact point window (Fig.38) toolbar. 

 

Here the results are recalculated with the contact 
point more precisely refined by the user  

Detect contact point  icon is active on Set the 
contact point window (Fig.39) toolbar. 

 

7.3 REVIEWING IMAGES 

 

Double click one image thumbnail in the gallery of the result 
analysis main window (Fig.55) to open Edit an image window 
(Fig.54). 

 
 
 
1 For our measurement example (Fig.49), only one indent (#1) is available. 
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7.4 SINUS ANALYSIS  

For Sinus measurement results 

 

 
Fig.57 Main window with sinus analysis of results 

 

On the left top side of the main window (Fig.57), Add analysis  icon to add a new 

Sinus method analysis. 

 

 

This window appears. 
 

 
Double click Sinus. 

 
In the main window (Fig.57) a new tab 
(e.g. tab #2) appears with: 

 

 Sinus analysis method results, 
parameters… on the left side 

 

 an additional upper graph area with the 
sinus curve results 
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7.5 SAVE, PRINT, STATISTICS/EXPORT 

7.5.1 SAVE 

Select "File > Save" from menu bar or click Save  icon on toolbar to open the 

following Save an indentation file window. 
 

 
 

 

 

Choose a location to 
save the 

measurement file on 
the acquisition 

system. 
 

Type a file name 
(automatic extension 
.mit) 

 
Then click <Save> 

button. 
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7.5.2 PRINT 

For further details, refer to the Common Scratch & Indentation software 

reference guide in sections Customizing options and Printing/PDF document 
reports. 
 

7.5.2.1 Report properties 

Select "File > Options…" from menu bar to open the following Options window 
(Fig.58). 

 
 
 

 
Fig.58 Document models tab 

To edit/create document 

models: 
 

Select Document models 

tab and click <Add> 
button to create a new 
model or select an 

existing document model 
in the list and click 

<Edit> button to change 
it. 

 

Then the Edit a document 

model window appears 
and includes several tabs 

in which the report 
properties can be 
configured (for printing 

then). 

  

List 
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7.5.2.2 Print preview 

Select "File > Print preview…" from menu bar or click Print preview  icon on 

toolbar to open the following 'Print preview' window. 
 

 
 

 

Print preview includes 
the configuration set in 
section 7.5.2.1 but it 

can also be changed by 
clicking <Report 

properties …> button, 
see Fig.60. 
 

Click Print  icon and 

see Fig.59. 

 

Click Save as PDF  

icon and see File info 
area in Fig.61. 
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7.5.2.3 Print 

Select "File > Print…" from  menu bar or click Print  icon on toolbar to open the 

following window (Fig.59). 
 

 
 

 
Fig.59 Print window 

 

 
Fig.60 Preview window 

Same Print or Preview windows 

Print report properties can also be 
changed here as follows. 
 

Select a Document model from 
"Name" drop-down menu. 
 

 
 

Then click <Edit> button to open 

the Edit a document model window 
which includes several tabs in 
which the report properties can be 

configured (for printing then). 
 

Other printing options are 
available as follows. 
 

Select the desired group(s) of the 
indentation measurements that 
should be printed from 

"<Groups > …" drop-down 
menu: 

"<All>" group(s), 
"<All relevant>"group(s), or 
one existing " 'Group name' ". 

 
Select the desired kind of 

indentation measurement(s) that 
should be printed from 
"<Indentation tests > …" drop-

down menu: 
"<All>" measurement(s), or 

"<All relevant>" 
measurement(s). 

  

"Default printer" 

"Default printer" 
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7.5.2.4 PDF 

Select "File > Save as PDF…" from menu bar to open the following window 

(Fig.61). 
 

 

 

 
Fig.61 Save as PDF window 

 

 
 

 
 
File info: 

Some fields can be 
modified/filled in. 

 
 
 

 
 

 
Otherwise it is the same 
explanations that 

previously described in 
Same Print or Preview 

windows, p. 98. 
 
Click <OK> button to valid. 

A 2nd Save as PDF window appears. 
Choose a location to save the PDF file on the acquisition system. 

Type a file name (automatic extension .pdf) 
Then click <Save> button. 
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7.5.3 STATISTICS/EXPORT 

Click Show the statistics  icon on toolbar to show the statistics view; see the 

following main window. 

 

 
 
In the current report (e.g. New report in Manage report area) or in each new one 

(clicking Create a new report  icon) 

 
In the tree, select by checking each group/measurement# boxes for which 

data/curves statistics should be performed; e.g. only 1 group and 1 

measurement#1 is available here  

 

Click Select statistics  icon to show/hide the statistics area and/or click Curves 

 icon to show/hide the curves area. Select the desired data and options (in 

statistics area: Results tree check boxes, additional toolbars check boxes and 
options - in curve area: Drop-down menus, check boxes, additional toolbox icon 
options…). 

 

Click 'Sheet'  icon to export in different ways the data/curve results in text 

files. 
 
For further details about statistics (cycles…) and export, refer to the Common 

Scratch & Indentation software reference guide in section Statistics. 
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8 PERFORMING A NEW MEASUREMENT 

8.1 WITH THE SAME SAMPLE 

To perform new indentation measurement(s) with the same sample and the same 
indenter, resume the procedure from section 6.3. 

 
Otherwise if the indenter should be changed, resume the procedure from 

section 5.6. 
 
 

8.2 WITH A NEW SAMPLE 

To carry out new indentation measurement(s) with a new sample but with the 

same indenter, resume the procedure from section 6. 
 
Otherwise if the indenter should be changed, resume the procedure from 

section 5.6. 
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9 MOUNTING HEAD BOTTOM PROTECTION COVER 

When the UNHT3 is not in use, it is advised to mount its head bottom cover in order 
to protect the indenter and reference. 
 

 Avoid any collision with the indenter/reference during the following operations. 

 

 
 

 

The cover is equipped with 2 captive 

hand screws in diagonal and 2 
positioning pins in opposite diagonal. 
 

Position the cover in order to see the 
'U' shape in front of the head. 

 
 

 
Fig.62 Head bottom 

- Tilt the protection cover forward to 

better see and carefully place the 'U' 
shape over and around the indenter 

and reference, avoid any 

collision between the 'U' shape sides 

and the indenter/reference 
 
- Then lightly press the protection 

cover against the head bottom. 
 

- Search the 2 pin holes by doing only 

longitudinal movements  no 

lateral movements. When cover pins 
are inserted, keep the cover pressed 

against the head bottom and (with 
other hand) tighten the 2 hand 
screws to lock the cover against the 

head bottom. 

  

Pins Screws 
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10 F.A.Q. 

10.1 WHY IS THE INDENT NOT UNDER THE VIDEO CROSSHAIR? 

Why is there an offset between the indent center and the video crosshair center 
after an indentation measurement? 

 
 

 The distance between the indenter and the video microscope is wrong: 
 

Perform a new Indenter-microscope distance calibration (section 5.10). 
 

 
 The sample moves during the indentation measurement, due to the indentation 

force: 
 

Tighten stronger the sample in the clamp jaws. 

 
 
 There was play in motorized X, Y tables: 
 

Select "Instrument > Hardware configuration…" from menu bar and in 
Hardware configuration window, click <Edit> button>. In the following 

Step - MHT - Hardware configuration window, select Motors tab and verify/set 
Backlash Correction field to 200 µm. 

 

 
 

Then click <Backlash> button (backlash correction) in Position control window 

(Fig.13) after the last manual move of the targeting process. This will remove 
the play of motorized X, Y tables. 
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10.2 WHY CAN I NOT REACH THE CONTACT LOAD? 

 The 2 pieces of masking tape on each side of the motorized head module are not 

removed: 
 

 
 

Remove the 2 pieces of masking tape. 
 

 Masking tape should only be present if the head/instrument is being sent 

back (for transport). 
  

Motorized module 
(e.g. without head) 
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10.3 WHY IS THE INDENT NOT AS EXPECTED? 

Why is the indent non-conform, not repeatable? 

 
 

 The distance between the indenter and the video microscope is wrong: 
 

Perform a new Indenter-microscope distance calibration (section 5.10). 

 
 
 The sample moves during the indentation measurement, due to the indentation 

force: 
 

Tighten stronger the sample in the clamp jaws. 

 
 

 The indenter extremity is: 
 

► Dirty, 
 

Clean indenter extremity and/or 
 

Perform an indentation at 50 mN in copper to remove dirt ; see 
section 0 

 

► Worn out for the application or damaged, 
 

Verify the wear by performing an indenter calibration (section 5.13) and 
then if it is necessary, 

 

Use a new indenter and review from section 5.6. 

  



 

G70IB003EN-A 106 

10.4 WHY IS THE ADO NOT SUCCESSFUL? 

Why has the ADO not been successfully performed? The automatic procedure has 

been interrupted and sometimes the following error status appears. 
 

 

 
 
Then there is no green circle with a tick on ADO 

 icon on toolbar. 

 The ADO pre-approach parameters values for the indenter and the reference are 

not suitable and should be adapted: 
 

Case a) 
 

 
 

Bad pre-approach 

While the motorized Z table approaches (moving 
up), the sample surface touches both reference 

and indenter or only the indenter. 
 

Depending on Indenter and Reference Pre-

approach fields (in Adjust depth offset 
parameters window), either the indenter value 
should be decreased by 10 % or more, or the 

reference value should be increased by 10 % or 
more. 
 

 
 

An ADO should be started again and if it is 

necessary, readjust those pre-approach values 

until it is successfully ( ) performed. 

I 

R 

Sample 
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Case b) 
 

 
 

Bad pre-approach 

The reference touches the sample surface but 
the indenter goes (down) to ~ 100 % (max) 

without having touched the sample surface. 
 

In this case (in Adjust depth offset parameters 

window) the Reference Pre-approach field value 
should be decreased by 10 % or more. 
 

 
 

An ADO should be started again and if it is 
necessary, readjust this pre-approach value until 

it is successfully ( ) performed. 
 

If the value is set to the minimum (advised not 

less than 5 %) and there is still the error, it 
means the sample is tilted too much and should 

be leveled. 

 

 The sample is tilted to much: 
 

Level the sample and then an ADO should be started again until it is 

successfully ( ) performed. 

 

 
 <Cancel> button has been clicked during the automatic ADO procedure (this 

stops the procedure and cancel the ADO): 
 

An ADO should be started again until it is successfully ( ) performed. 

 

 
See the ADO (section 5.11). 

  

 

I 
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Remaining piezo displacement range 
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10.5 WHY IS THE DEPTH SIGNAL SATURATED? 

See the following graphs. 

 

 
Fig.63 Saturation 1. 

 
Fig.64 Saturation 2. 

 

 The sample is very soft which gives a large penetration depth during the 
measurement (Fig.63) : 

 

OR 
 

 There is a certain relief on the sample (can be a too high roughness). The 
measurement is performed in a hole: the approach distance is increased which 

may saturate the depth (Fig.64) 
 

 : 

 
Before starting a new measurement 
 

Select the large Depth range radio button, e.g. <50 µm> (instead of fine 
<10 µm>) in Sensor range tab of Hardware parameters window (Fig.51). 

  

Reference 

Sample topography 

Indenter 

ADO START MEASUREMENT APPROACH 

Approach distance 
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10.6 WHY IS THE FORCE DISPLACEMENT CURVE LINEAR? 

Even with a Vickers or Berkovich indenter? See the following graphs. 
 

The indenter is already in the sample surface before the approach 
 

 
 

 

 
Fig.65 Approach very short 

(in Set the contact point window) 

 
 
 

 
Fig.66 Approach very long, F increases 

(in Set the contact point window) 

 

 The ADO is performed in a hole. Then the approach distance is not sufficient and 

this way the indenter starts the measurement already in the sample 
 

 : 

OR 
  

Reference 

Sample topography 

Indenter 

START MEASUREMENT APPROACH ADO 

Approach distance 

Linear 

Instead of parabolic 

Linear 

Instead of parabolic 
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 During the ADO the indenter penetrates too much in the sample because of 

sample softness. Then the approach distance is not sufficient and this way the 
indenter starts the measurement already in the sample 

 

 : 
 

OR 
 

 There is a certain relief on the sample (can be a too high roughness). The 
measurement is performed on a bump: the approach distance is not sufficient 

and this way the indenter starts the measurement already in the sample 
 

 : 

 
Before starting a new measurement, in order to increase the approach distance 

 

Set a greater value in Approach distance field, e.g. > 3'000 nm in Preferences 
tab of Hardware parameter window (Fig.50). 

 

 If the value is too much increased, then it is possible that the depth signal 

saturates (section 10.5). 
 

 
 
 

 
Fig.67 Approach Ok 

(in Set the contact point window) 

  

Reference 

Sample topography 

Indenter 

ADO START MEASUREMENT APPROACH 

Approach distance 

Reference 

Sample topography 

Indenter 

ADO START MEASUREMENT APPROACH 

Approach distance 

Ok, parabolic curve (for Vickers and Berkovich) 
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10.7 WHY DOES THE INSERT AN ADJUST DEPTH OFFSET WINDOW APPEAR? 

Why this window appears before running an indentation measurement? 

 

 
 
 
 No ADO has been performed or the last ADO was not successfully performed (no 

green circle with a tick on ADO  icon on toolbar): 
 

Edit these ADO parameters and position, 
 

◦ click <Edit adjust depth offset parameters> button, this opens the Adjust 
depth offset parameters window (Fig.24). 

 

◦ set suitable values1 in Delta X and Y position fields, this will shift the 

current position for this ADO (and then when ADO procedure is finished, it 
will come back where it was before running the indentation measurement) 
and click <OK> button to start this ADO before running the indentation 

measurement. 
 

OR 
 

Click <Cancel> button to abort this ADO which aborts also the indentation 
measurement. Thus an ADO with the standard method, described in 

section 5.11, should be successfully ( ) performed before running an 

indentation measurement. 
 

 
 

 
 
 
1 Not too much, otherwise the sample topography may vary. 
 IMPORTANT: Pay attention to the displacement unit (e.g. mm here), which is set in the 

options; refer to the Common Scratch & Indentation software reference guide in 

section Customizing options / Preferences tab (units). 
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10.8 WHY DOES "HC OUT OF CALIBRATED RANGE" MESSAGE APPEAR? 

Why in the main result analysis window under Hypothesis does the message "hc out 

of calibrated range [# nm, # nm]" appears? 
 

 
 

 
 The hc of the measurement Additional results is out of the known calibration 

range: 
 

Refer to the Indentation software reference guide in section Analysis of 

results / Hypothesis / Out of indenter tip calibration. 
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11 BLOCKING ERROR MESSAGES 

This section shows the main blocking error messages and describes propositions to 
try removing the cause of each error. However if a problem persists, try switching 
off the system: First close the software, then shut down the acquisition system by 

software (Windows®) and then switch off the instrument using the main power 
switch. Wait about 20 sec, then switch on the instrument using the main power 

switch and then open the software and try again to see if this has solves the 
problem. 
 

 

11.1 CONNECTION TO CONTROL UNIT FAILED. 

The control unit cannot connect. 
 
 

(Detect error : No Card selected) 
 

 
 

 
Verify that the IO card is selected ("Instrument > Hardware configuration…" 

menu bar / <Edit> button / Control unit & modules tab / <Choose card> button). 
 
 

(Error detected : Voltage not present) 
 

 
 

 
Verify that the Step is switched on (power cables plugged). 
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(Error detected : No Communication) 
 

 
 
 
Verify that the communication Ethernet cable is connected (on acquisition system 

and on Step rear panels). 
 

 
(Detected error : missing connection. check cable and… 
 

 
 
 
Verify that the motor cables are connected to the Step. 

 
 

11.2 YOUR INSTRUMENT RANGES HAVE NOT BE VALIDATED! 

An ADO, calibration or measurement is not carried on. 
 

 
 

Refer to the Common Scratch & Indentation software reference guide in 
section Managing the instrument / Hardware configuration / 'Ranges' tab(s) 

before starting a new measurement. 
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11.3 MOTORIZED TABLES 

Motorized tables are no longer controlled: Fatal error. 

 
 

Cannot get current position on motor 0 
 

 
 

 
Cannot Initialize motor Nb 1. 
 

 
 
 

Error Reading Boolean in API msg 1123 / 1327! 
 

 /  

 
Close the software, then shut down the acquisition system by software (Windows®) 
and then switch off the instrument using the main power switch. Wait at least 20 

sec, then switch on the instrument using the main power switch and then open the 
software. 

 
Verify the voltage network quality (it should be stable). 
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11.4 VIDEO SOFTWARE 

The Video Software does not work. 

 
 

Cannot run the Video Module. The module is not properly… 
 
Cannot run the Video Software. 

 

 
 
This software is too old or not properly installed; try to reinstall a recent Video 
Software. 

 
 

The program can’t start because uEye_api.dll is missing from… 
 
Cannot properly use the software. 

 

 
 

 
 

The camera driver is not properly installed; try to reinstall the camera driver (in the 
setup Video.exe). 
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11.5 CAN NOT WRITE ADDRESS 

Communication trouble with video microscope light source. 

 

 
 

Verify that the video microscope cables are correctly plugged. 
 
 

11.6 PREVIOUS DAQMX DRIVER VERSION DETECTED 

When starting the software, if the following message appears, 
 

DaqMx Drivers 9.2 (or 8.6) detected! You have to install DaqMX 16.1 or higher 
 

 
 

it means that a previous driver version (under DaqMx 16.1) is installed in the 
acquisition system. 

 
Contact us: www.anton-paar.com to ask for the latest driver version, in order to 
proceed with an update. Otherwise bad acquisitions can be performed and therefore 

wrong results can be obtained. 
 
 

11.7 DURING AN ADO, A CALIBRATION OR AN INDENTATION MEASUREMENT 

The ADO, the calibration or the indentation measurement is not carried on. 
 

 
An error occurred : EIndentationInstrumentError - Could not… 

 

The instrument range cannot be reached. 
 

 
 

Start a new ADO until is successfully ( ) performed before starting a new 

calibration or a new indentation measurement. 

  

http://www.anton-paar.com/
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An error occurred: EIndentationInstrumentError - Sample in contact… 
 

The sample surface has touched the indenter before the reference. 
 

      
 

 
 

 
 

Bad pre-approach 

While the Z table approaches (moving up), the 
sample surface touches both the reference and the 
indenter or only the indenter. 
 

Depending on pre-approach parameters of the 
indenter and reference (in Preferences window and 

tab), either the indenter value should be 
decreased by 10 % or more, or the reference 
value should be increased by 10 % or more. 

 

 
 

Start again the measurement and if necessary 
readjust those pre-approach values until the 

indentation measurement correctly runs until the 
end. 
 

Otherwise start a new ADO1 until it is successfully 

( ) performed before starting a new indentation 

measurement1 

 
1 Previously, verify and if necessary, change the ADO parameters and then the hardware 

parameter preferences for the indentation measurement. 
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An error occurred : EIndentationInstrumentError - Altitude (z) of… 
 

The altitude (z) of the indenter is undefined. 
 

 
 

Start a new ADO1 until it is successfully ( ) performed before starting a new 

calibration or a new indentation measurement1 
 

 
An error occurred: EIndentationInstrumentError - Force signal… 

 
The force signal is in saturation, the indenter-reference vertical distance is too 
large. 

 

 
 

Start a new ADO1 until it is successfully ( ) performed before starting a new 

calibration or a new indentation measurement1 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 
1 Previously, verify and if necessary, change the ADO parameters and then the preferences 

parameters of the indentation measurement. 
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An error occurred: EIndentationInstrumentError - The surface… 
 

The sample surface has touched the indenter during the pre-approach. 
 

 
 

Start a new ADO1 until it is successfully ( ) performed before starting a new 

calibration or a new indentation measurement1 

 
An error occurred: EIndentationInstrumentError - Can not Remove 
from… 

 
The reference contact cannot be removed with the motorized Z table. 

 

 
 

 
 

Start a new ADO1 until it is successfully ( ) performed before starting a new 

calibration or a new indentation measurement1 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
1 Previously, verify and if necessary, change the ADO parameters and then the preferences 

parameters of the indentation measurement. 
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If problems should be encountered, refer to this document and to the 

others mentioned. 
 

Otherwise contact us, 
 

 
 

www.anton-paar.com 

http://www.anton-paar.com/
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